
1Managing E-Mail and 
Contacts with Outlook

• Start and quit Outlook

• Open, read, print, reply to, and 
delete electronic mail messages

• View a fi le attachment

• Create and insert an e-mail signature

• Compose, format, and send e-mail 
messages

• Insert a fi le attachment in an e-mail 
message

• Flag, categorize, sort, and fi lter 
e-mail messages

• Set e-mail importance, sensitivity, 
and delivery options

• Create a personal folder

• Create and print a contact list

• Use the Find a Contact feature

• Organize the contact list

• Track activities of a contact

• Use Outlook’s Help

Objectives
You will have mastered the material in this chapter when you can:

Microsoft Offi ce Outlook 2007
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What Is Microsoft Offi ce Outlook 2007?
Microsoft Offi ce Outlook 2007, usually referred to as simply Outlook, is a powerful 
communications and scheduling program that helps you communicate with others 
(Figure 1-1), keep track of your contacts, and organize your calendar. Personal information 
management (PIM) programs such as Outlook provide a way for individuals and work-
groups to organize, fi nd, view, and share information easily. Outlook allows you to send 
and receive electronic mail (e-mail) and permits you to engage in real-time messaging with 
family, friends, or coworkers using instant messaging. Outlook also provides you with the 
means to organize your contacts. Users can track e-mail messages, meetings, and notes 
related to a particular contact. Outlook’s Calendar, Contacts, Tasks, and Notes components 
aid in this organization. Contact information readily is available from the Outlook 
Calendar, Mail, Contacts, and Task components by accessing the Find a Contact feature. 

Electronic mail (e-mail) is the transmission of messages and fi les over a computer 
network. E-mail has become an important means of exchanging information and fi les 
between business associates, classmates and instructors, friends, and family. Businesses fi nd 
that using e-mail to send documents electronically saves both time and money. Parents with 
students away at college or relatives who are scattered across the country fi nd that communi-
cating by e-mail is an inexpensive and easy way to stay in touch with their family members. In 
fact, exchanging e-mail messages is one of the more widely used features of the Internet.

This latest version of Outlook has many new features to help make you more 
productive. For example, Outlook now offers Instant Search, which fi nds your information, 
no matter which folder it is in. Outlook also has added Color Categories, which let you apply 
the same color category to e-mail, calendar, and task items so you can visually locate all asso-
ciated items.  Outlook has added fl ags you can use to create and mark a follow-up item for 
tracking. The new To-Do Bar is a feature that integrates tasks, e-mail messages fl agged for 
follow up, and calendar information in a toolbar located adjacent to the reading pane.

To illustrate the features of Outlook, this book presents a series of projects that use 
Outlook to create and send e-mail messages and create and manage a contact list. 

The process of composing an e-mail message that communicates specifi c information 
requires careful analysis and planning. As a starting point, establish why the message is 
needed. Once the purpose is determined, analyze the intended readers of the message and 
their unique needs. Then, gather information about the topic and decide what to include in 
the message. Finally, determine the document design and style that will be most successful at 
delivering the message. Creating a contact list is simply a matter of who you want to add to 
the list. The contact list can be used to store people you have frequent contact with via 
e-mail, telephone, or fax. The contact list can also be used as a mailing list. Each project in 
this book provides practical applications of these planning considerations.

Project Planning 
Guidelines

Microsoft Offi ce Word 2003Microsoft Offi ce Outlook 2007

1 Managing E-Mail and Contacts 
with Outlook

OUT 2
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(c) E-Mail Message 
with Attachment

(a) Contact List
User

THE INTERNET

(b) E-Mail Message Requesting 
Information

Recipient

Figure 1–1

(d) E-Mail Attachment 
Opened

Project — Communicating Over the Internet
The project in this chapter follows general guidelines and uses Outlook to create the 
contacts and messages shown in Figure 1–1. To communicate with individuals and groups, 
you typically send or deliver some kind of message. Telephone calls, faxes, and letters are 
examples of messages. E-mail is a convenient way to send information to multiple recipients 
simultaneously, instantly, and inexpensively.
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As the captain of the Donner Community College baseball team, you use Outlook 
to keep the players up to date with team information using your school e-mail system. You 
also use the contact list to store addresses and phone numbers of each member of the team. 
The project uses the communications features of Outlook to compose, send, and read e-mail 
messages. In addition to using Outlook’s communication tools, this project shows you how 
to create and organize a contact list. Using the contact list (Figure 1–1a), a user selects a 
recipient for an e-mail message and then sends an e-mail message requesting information 
from the recipient (Figure 1–1b). The recipient replies by sending an e-mail message 
(Figure 1–1c) and includes the requested information as an attachment (Figure 1–1d), or a 
fi le included with the e-mail message, that the recipient can open. 

Overview
As you read this chapter, you will learn how to communicate over the Internet as 

shown in Figure 1–1 by performing these general tasks:

• Open and read e-mail messages.
• Print an e-mail message.
• Reply to and forward an e-mail message.
• View a fi le attachment.
• Create an e-mail signature.
• Compose and format an e-mail message.
• Attach a fi le to an e-mail message.
• Organize and sort e-mail messages.
• Create and organize a contact list.
• Print a contact list.

General Project Guidelines
When creating an e-mail message, the actions you perform and decisions you make will 
affect the appearance and characteristics of the fi nished message. As you create an e-mail 
message such as those shown in Figure 1–1, you should follow these general guidelines:

1. Choose the words for the Subject line. The Subject line should indicate the main subject of 
the message. Use as few words as possible. You should never leave the Subject line blank. 

2. Ensure that the content of the message is appropriate for the recipient. An e-mail sent 
to a close friend may be considerably different from one sent to an instructor, coworker, 
or client. Use e-mail etiquette when composing your message. For work related e-mails, 
avoid shortening words or using abbreviations (i.e., u for you, r for are, 2 for to, etc.).

3. Choose the words for the text. Follow the less is more guideline. The less text, the more 
likely the message will be read to completion. Use as few words as possible to make a point. 

4. Identify how to format various elements of the text. The overall appearance of a 
message signifi cantly affects its ability to communicate clearly. Examples of how you can 
modify the appearance, or format, of text include changing its shape, size, color, and 
position on the page.

5. Alert the recipient when sending large fi le attachments. Some e-mail servers allow fi le 
attachments up to a certain size. If possible, compress large fi les using WinZip or comparable 
software. If several attachments are required, you may have to send multiple e-mails.

When necessary, more specifi c details concerning the above guidelines are presented at 
appropriate points in the chapter. The chapter also will identify the actions performed and 
decisions made regarding these guidelines during the creation of the messages shown in 
Figure 1–1.

Plan
Ahead
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Starting and Customizing Outlook
If you are using a computer to step through the project in this chapter and you want your 
screen to match the fi gures in this book, you should change your screen’s resolution to 
1024 � 768. For information about how to change a computer’s resolution, read Appendix E.

To Start and Customize Outlook

The following steps, which assume Windows is running, start Outlook based on a typical installation. You may 
need to ask your instructor how to start Outlook for your computer.

1
• Click the Start button on the 

Windows taskbar to display the 
Start menu.

• Point to All Programs on the Start 
menu to display the All Programs 
submenu.

• Point to Microsoft Offi ce on the 
All Programs submenu to display 
the Microsoft Offi ce submenu 
(Figure 1–2).

Figure 1–2

All Programs 
submenu

Microsoft Offi ce 
submenu

Microsoft 
Offi ce 
Outlook 
2007 
command

All Programs 
command

Microsoft Offi ce 
command

Windows 
taskbar

Windows displays 
commands on the 
Start menu above 
the Start button

Start button

Starting and Customizing Outlook   OUT 5
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OUT 6   Outlook Chapter 1   Managing E-Mail and Contacts with Outlook

2
• Click Microsoft Offi ce Outlook 2007 to start Outlook. If necessary, click the Mail button in the Navigation Pane and then 

click the Inbox folder in the All Mail Folders pane to display the Inbox message pane (Figure 1–3).

• If the Inbox – Microsoft Offi ce Outlook window is not maximized, click the Maximize button next to the Close button on 
its title bar to maximize the window.

What is a maximized window? 

A maximized window fi lls the entire screen. When you maximize a window, the Maximize button changes to a Restore 
Down button. 

3
• Drag the right border of the Inbox message pane to the right so that the Inbox message pane and the Reading pane 

have the same width.

Menu bar

Title bar

Standard 
toolbar

Inbox – Microsoft 
Outlook window

Mail button 

Inbox folder

Mail Folders 
pane

right border of Inbox 
message pane 

Inbox message 
pane Reading PaneNavigation Pane

To-Do Bar

Figure 1–3

Other Ways

1. Double-click Outlook 
icon on desktop, if one 
is present

2. Click Microsoft Offi ce 
Outlook 2007 on 
Start menu

Q
&

A

Restore Down 
button
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The Inbox — Microsoft Outlook Window
The Inbox – Microsoft Outlook window shown in Figure 1–3 comprises a number of 
elements that you will use consistently as you work in the Outlook environment. Figure 1–4 
illustrates the Standard toolbar, located below the title bar and the menu bar. The Standard 
toolbar contains buttons specifi c to Outlook. The button names indicate their functions. 
Each button can be clicked to perform a frequently used task, such as creating a new mail 
message, printing, or sending and receiving mail.

Figure 1–4

The Inbox – Microsoft Outlook window is divided into four panes: the Navigation 
Pane on the left side of the window, the Inbox message pane to the left of center, the 
Reading pane to the right of center, and the To-Do Bar on the far right side of the window 
(Figure 1–5 on the next page).

Navigation Pane The Navigation Pane (Figure 1–5) is set up to help you navigate 
Microsoft Outlook while using any of the program’s components (Mail, Calendar, 
Contacts, or Tasks). It comprises one or more panes and two sets of buttons. Although the 
two sets of buttons remain constant, the area of the Navigation Pane above the buttons 
changes depending on the active Outlook component. When you click the Mail button, 
Outlook displays Mail in the title bar of the Navigation Pane. When using Mail, the 
Navigation Pane includes two panes: Favorite Folders and Mail Folders. The Favorite 
Folders pane contains duplicate names of your favorite folders in the Mail Folders pane. To 
add a folder in the Mail Folders pane to the list of favorite folders, right-click the folder and 
then click the Add to Favorites Folders.

Below the Favorite Folders pane, the Mail Folders pane contains a set of folders 
associated with the communications tools of Outlook Mail (Deleted Items, Drafts, Inbox, 
Junk E-mail, Outbox, RSS Feeds, Sent Items, and Search Folders).

The Deleted Items folder holds messages that you have deleted. As a safety 
precaution, you can retrieve deleted messages from the Deleted Items folder if you later 
decide to keep them. Deleting messages from the Deleted Items folder permanently 
removes the messages from Outlook. The Drafts folder retains copies of messages that 
you are not yet ready to send. The Inbox folder is the destination for incoming mail. 
The Junk E-mail folder is the destination folder for unwanted messages or messages of 
an unknown origin. You can customize the settings for Outlook to direct only messages 
that meet certain criteria to the Inbox folder. Messages not meeting those criteria are 
sent to the Junk E-mail folder. The Outbox folder temporarily holds messages you send 
until Outlook delivers the messages. The RSS Feeds folder is new to Outlook. Really 
Simple Syndication (RSS) feeds allow you to receive current information from sources 
that are updated frequently, such as news headlines or blogs, without having to visit the 
various Web sites. The Sent Items folder retains copies of messages that you have sent. 
The Search Folders folder is actually a group of folders that allows you to group your 
messages easily in one of three ways – messages for follow up, large messages, or unread 
messages.

The Inbox — Microsoft Outlook Window   OUT 7

Microsoft Offi ce 
Outlook Help

Reply

Reply to 
AllDeletePrint Categories Send/Receive Toolbar OptionsSearch address 

books 

New Mail 
Message

Move to 
Folder Forward Follow Up

Create Rule

Address Book

The Inbox Window
The screen in 
Figure 1–3 on the 
previous page shows how 
the Inbox window looks 
after you have received 
several e-mail messages. 
Your screen may look 
different depending on 
your screen resolution 
and Outlook settings.
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W
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OUT 8   Outlook Chapter 1   Managing E-Mail and Contacts with Outlook

Folders can contain e-mail messages, faxes, and fi les created in other Windows 
applications. Folders in bold type followed by a number in parentheses, such as Inbox (4), 
indicate the number of messages in the folder that are unopened. Other folders may appear 
on your computer instead of or in addition to the folders shown in Figure 1–5.

The two sets of buttons at the bottom of the Navigation Pane contain shortcuts to 
the major components of Outlook (Mail, Calendar, Contacts, Tasks, Notes, Folder List, 
Shortcuts, and Confi gure buttons).

Message Pane The Inbox message pane (shown in Figure 1–5) lists the contents of 
the folder selected in the Mail Folders pane. In Figure 1–5, the Inbox folder is selected. 
Thus, the message pane lists the e-mails received. 

Figure 1–6 shows the Arranged By shortcut menu that appears when you click or 
right-click the Arranged By column header in the Inbox message pane. The command you 
choose on the Arranged By shortcut menu causes Outlook to display a column header to 
the right indicating the sort order within the Arranged By grouping. In Figure 1–5, the 
Arranged By option is Date. This predefi ned pairing of a grouping and a sort (Arranged 
By: Date/Newest on top) is called an arrangement. Predefi ned arrangements allow you 
to sort your messages in various ways. 

Several small icons may appear to the right of a message: an exclamation point icon 
indicates that the message is high priority and should be read immediately, a paper clip icon 
indicates that the message contains an attachment. A message heading that appears in bold 

Figure 1–5

Navigation 
Pane

Inbox message 
pane

Jose Quinteras message 
heading selected

Reading pane

Tasks

Notes

Folder List

selected message 
appears in 
Reading pane

exclamation point 
icon indicates 
urgent status

Mail Folders 
pane

Favorite 
Folders pane

Confi gure 
buttons

Mail pane

Mail

Calendar

Contacts

Shortcuts

button 
selected 
indicates 
active pane 
in Navigation 
Pane

paper clip icon 
indicates a fi le 
attachment

open envelope 
icons

closed envelope 
icons for unread 
mail

message pane 
contains selected 
folder name as title

message heading 
of selected e-mail 
message in Inbox 
message pane To-Do Bar

e-mail 
message
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type with a closed envelope icon to the left identifi es an unread e-mail message. An open 
envelope icon indicates a read message. In Figure 1–5, the second e-mail message is high-
lighted and therefore is displayed in the Reading Pane on the right. The closed envelope 
icon and bold message heading indicate the e-mail message has not been read. The e-mail 
messages on your computer may be different.

The closed envelope icon is one of several icons called message list icons, which 
appear to the left of the message heading. Message list icons indicate the status of the 
message. The icon may indicate an action that was performed by the sender or one that 
was performed by the recipient. The actions may include reading, replying to, forwarding, 
digitally signing, or encrypting a message. Table 1–1 contains a partial list of message list 
icons and the action performed on the e-mail message.

sort is Newest 
on top

Arranged By 
shortcut menu

grouping is 
Arranged By: Date

check mark indicates 
selected command for 
arrangement

Figure 1–6

The Inbox — Microsoft Outlook Window   OUT 9

arrangement (pairing 
of grouping and sort)

Table 1–1 Message List Icons and Actions 

Message List Icon Action Message List Icon Action

The message has been 
opened.

The message is in progress 
in the Drafts folder.

The message has not been 
opened.

The message is digitally 
signed and unopened.

The message has been 
replied to.

The message is digitally 
signed and opened.

The message has been 
forwarded.

Reading Pane The Reading pane (Figure 1–5) contains the text of the selected e-mail 
message. The message header appears at the top of the Reading pane and contains the 
e-mail subject (First Practice), the sender’s name and/or e-mail address (Jose Quinteras 
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[josequinteras123@hotmail.com]), and the recipient’s e-mail address (marcuscook1@ 
comcast.net). Outlook displays the text of the selected message below the message header. 
Using the View menu, you can display the Reading pane to the right of the message pane 
(vertically), as shown in Figure 1–5 on page OUT 8, or you can display it at the bottom of 
the message pane (horizontally) according to your personal preference.

To-Do Bar The To-Do Bar is a new feature in Outlook 2007. The To-Do Bar keeps 
e-mail messages fl agged for follow up, tasks, appointments, and other calendar informa-
tion in one place. When displayed, the To-Do Bar contains a Date Navigator, an appoint-
ment list, and a task list. The To-Do Bar is displayed by clicking the double arrow button 
at the top of the To-Do Bar (Figure 1–5).

Working with Incoming Messages

Note: If you are stepping through this project on a computer and you want your screen to appear the 
same as in the figures in the Mail component section of this project, then you should ask your instructor 
to help you (or see page OUT 67) to import Marcus’ Inbox from the Data Files for Students. Once you 
have imported Marcus’ Inbox, click the plus sign (+) next to the Inbox folder in the Mail Folders list, and 
then select Marcus’ Inbox folder. See the inside back cover of this book for instructions for downloading 
the Data Files for Students or see your instructor for information about accessing files for this book.

To Open (Read) an E-Mail Message

To view the complete message in its own window, it must be opened. The following step opens the e-mail 
message from Jose Quinteras.

1
• Double-click the Jose Quinteras 

message heading in the Inbox 
Message pane to display the First 
Practice window (Figure 1–7).

• If necessary, maximize the window.

What happens to the message 
heading in the Message pane after 
the message is opened? 

When you double-click the 
message heading in the Message 
pane, Outlook changes the closed 
envelope icon to an opened enve-
lope icon, and no longer displays 
the message heading in bold type. 

Figure 1–7

window title (e-mail 
subject) in maximized First 
Practice – Message window

message 
body

identifying 
information

Other Ways

1. Right-click message 
heading, click Open on 
shortcut menu

2. Click message heading, 
on File menu point to 
Open, click Selected 
Items on Open submenu

3. Select message heading, 
press CTRL+O

Q
&

A

Reading E-Mail 
Messages
If Outlook is not the 
active window on your 
screen, it still provides 
a mail notifi cation alert 
informing you when you 
receive a new message. 
Outlook displays a 
semitransparent Screen 
Tip momentarily by the 
Outlook icon in the 
notifi cation area, showing 
the sender’s name, 
subject of the message, 
and the fi rst few words 
of the message body.

B
T
W

C6168_OUT_01.4c.indd   10C6168_OUT_01.4c.indd   10 3/7/07   10:45:14 AM3/7/07   10:45:14 AM



O
u

tl
o

o
k 

C
h

ap
te

r 
1

Ribbon
The Ribbon, located near the top of the Outlook window, is the control center in Out-

look (Figure 1–8a). The Ribbon provides easy, central access to the tasks you perform while 
creating or working with a message, contact, calendar item, or task. The Ribbon consists of 
tabs, groups, and commands. Each tab surrounds a collection of groups, and each group con-
tains related commands. Figure 1–8a illustrates the Ribbon for the Message window. 

When you open a message, the Message window Ribbon displays the Message tab. 
The Message tab contains the more frequently used commands.

To display more of the document in the document window, some users prefer to 
minimize the Ribbon, which hides the groups on the Ribbon and displays only the Message 
tab (Figure 1–8b). To use commands on a minimized Ribbon, click the top-level tab.

Each time you open a message, the Ribbon appears the same way it did the last time 
you used Outlook. The chapters in this book, however, begin with the Ribbon appearing as 
it did at the initial installation of the software. If you are stepping through this chapter on a 
computer and you want your Ribbon to match the fi gures in this book, read Appendix E.

Working with Incoming Messages   OUT 11

(a)
Ribbon 

Message tab

groups 

minimized Ribbon 

Figure 1–8

(b)

Some commands on the Ribbon display an image to help you remember their 
function. When you point to a command on the Ribbon, all or part of the command glows 
in shades of yellow and orange, and an Enhanced ScreenTip appears on the screen. An 
Enhanced ScreenTip is an on-screen note that provides the name of the command, available 
keyboard shortcut(s), a description of the command, and, sometimes, instructions for how to 
obtain help about the command (Figure 1–9). Enhanced ScreenTips are more detailed than 
a typical ScreenTip, which usually only displays the name of the command.

Figure 1–9

image of Reply icon 
helps to identify 
Reply button

mouse pointer on 
Reply button

Enhanced 
ScreenTip for 
Reply button 
arrow

Minimizing the Ribbon
If you want to minimize 
the Ribbon, right-click 
the Ribbon and then click 
Minimize the Ribbon 
on the shortcut menu, 
double-click the active 
tab, or press CTRL+F1. 
To restore a minimized 
Ribbon, right-click the 
Ribbon and then click 
Minimize the Ribbon 
on the shortcut menu, 
double-click any top-level 
tab, or press CTRL+F1. 
To use commands on a 
minimized Ribbon, click 
the top-level tab.
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Quick Access Toolbar
The Quick Access Toolbar, located by default above the Ribbon, provides easy 

access to frequently used commands (Figure 1–11a). The commands on the Quick Access 
Toolbar always are available, regardless of the task you are performing. Initially, the Quick 
Access Toolbar contains the Save, Undo, and Redo commands. If you click the Customize 
Quick Access Toolbar button, Outlook provides a list of commands you quickly can add to 
and remove from the Quick Access Toolbar (Figure 1–11b). 

You also can add other commands to or delete commands from the Quick Access 
Toolbar so that it contains the commands you use most often. As you add commands to 
the Quick Access Toolbar, its commands may interfere with the document title on the title 
bar. For this reason, Outlook provides an option of displaying the Quick Access Toolbar 
below the Ribbon (Figure 1–11c). 

Each time you start Outlook, the Quick Access Toolbar appears the same way it 
did the last time you used Outlook. The chapters in this book, however, begin with the 
Quick Access Toolbar appearing as it did at the initial installation of the software. If you 
are stepping through this chapter on a computer and you want your Quick Access Toolbar 
to match the fi gures in this book, you should reset your Quick Access Toolbar. For more 
information about how to reset the Quick Access Toolbar, read Appendix E.

The lower-right corner of some groups on the Ribbon has a small arrow, called a 
 Dialog Box Launcher, that when clicked displays a dialog box or a task pane with addi-
tional options for the group (Figure 1–10). When presented with a dialog box, you make 
selections and must close the dialog box before returning to the document. A task pane, by 
contrast, is a window that can remain open and visible while you work in the document.

Figure 1–10

clicking Dialog Box 
Launcher in Junk E-mail 
group displays Junk E-mail 
Options dialog boxJunk E-mail Options 

dialog box
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Offi ce Button
While the Ribbon is a control center for creating documents, the Offi ce Button is a 

central location for managing Outlook items. When you click the Offi ce Button, located in 
the upper-left corner of the window, Outlook displays the Offi ce Button menu (Figure 1–12). 
A menu contains a list of commands.

Figure 1–11

Customize 
Quick Access 
Toolbar button

Customize Quick 
Access Toolbar menu

commands you can 
add to or delete from 
Quick Access Toolbar

Save button

Undo button
Redo button

Previous message 
button

Next message 
button

Quick Access Toolbar 
positioned above Ribbon

(a)  Quick 
Access 

Toolbar 
above 

Ribbon

Quick Access 
Toolbar positioned 
below Ribbon

Figure 1–12

list of Outlook 
commands

Offi ce Button 
menu

Offi ce Button

Quick Access Toolbar 
Commands
To add a Ribbon 
command to the Quick 
Access Toolbar, right-click 
the command on the 
Ribbon and then click Add 
to Quick Access Toolbar 
on the shortcut menu. 
To delete a command 
from the Quick Access 
Toolbar, right-click the 
command on the Quick 
Access Toolbar and then 
click Remove from Quick 
Access Toolbar on the 
shortcut menu. To display 
the Quick Access Toolbar 
below the Ribbon, 
right-click the Quick 
Access Toolbar and then 
click Show Quick Access 
Toolbar below the Ribbon 
on the shortcut menu.

B
T
W

(c)  Quick Access Toolbar below Ribbon (b)  Quick Access Toolbar Customization options
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Key Tips
If you prefer using the keyboard instead of the mouse, you can press the ALT key on 

the keyboard to display a Key Tip badge, or keyboard code icon, for certain commands 
(Figure 1–14). To select a command using the keyboard, press its displayed code letter, or 
Key Tip. When you press a Key Tip, additional Key Tips related to the selected com-
mand may appear. For example, to select the New Mail Message command on the Offi ce 
Button menu, press the ALT key, then press the F key, and then press the N key. 

Figure 1–13

submenu

pointing to the command 
or to the arrow causes a 
submenu to be displayed

When you click the New Mail Message command, Outlook opens the message 
window to compose a new mail message. When you click the Save command, Outlook 
saves any changes you may have made to the message.  When you click the Save As, Move, 
Permission, Print, and Properties commands on the Offi ce Button menu, Outlook displays a 
dialog box with additional options. When you click the Delete command, Outlook sends the 
current message to the Deleted Items folder. When you click the Close command, Outlook 
closes the Message window. The Save As, Move, Permission, and Print commands have an 
arrow to their right. If you point to this arrow, Outlook displays a submenu, which is a list 
of additional commands associated with the selected command (Figure 1–13). 

Key Tip badges appear 
when you press ALT 
key on keyboard

Figure 1–14

To remove the Key Tip badges from the screen, press the ALT key or the ESC key 
until all Key Tip badges disappear, or click the mouse anywhere in the Message window.

Spam Filters
If an individual or 
company is not 
receiving e-mail from 
you, it is likely that the 
recipient’s ISP spam 
fi lter is not allowing 
it through to their 
mailbox. Try sending the 
message in Plain Text 
format, because spam 
fi lters are less likely to 
drop an e-mail in Plain 
Text format. 

B
T
W
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To Close an E-Mail Message

After reading the message from Jose, Marcus closes it. The following step closes the Message window.

1
• Click the Close button on the title 

bar (Figure 1–15) to close the 
Message window

Why did the number next to the 
Inbox folder change from 4 to 3? 

When you close the Message 
window, the Jose Quinteras mes-
sage heading in the message 
pane no longer appears in bold 
type and the closed envelope icon 
changes to an open envelope icon 
to indicate the message has been 
opened. In addition, the Inbox 
folder in the Mail Folders pane 
indicates three messages remain 
unopened. 

Figure 1–15

Close button

Figure 1–16

Print button Inbox window

Inbox folder

three unopened 
messages displayed 
in message pane

open 
envelope icon

Other Ways

1. On File Menu click Close

2. Press ALT+F4 

Q
&

A

To Print an E-Mail Message

Often, you will want to have a hard copy of your e-mail messages. You print the contents of an e-mail message 
from the Inbox window. The following steps print the e-mail message from Jose Quinteras.

1
• Point to the Print button on the 

Standard toolbar (Figure 1–16).
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2
• Click the Print button 

to print the message 
shown in Figure 1–17.

recipient’s name 
and horizontal 
line header

e-mail message

From, Sent, To, and 
Subject entries

page number prints at 
bottom of page

Figure 1–17

To Reply to an E-Mail Message

The Reply button allows you to reply quickly to an e-mail message using the sender’s e-mail address. The 
following steps reply to the e-mail message from Jose Quinteras.

1
• If necessary, click the Jose 

Quinteras message heading in the 
message pane (Figure 1–18).

Figure 1–18

Reply button Forward 
button

message 
selected

header

1. On File Menu click Print, 
click OK button

2. Press ALT+F, press P, 
press ENTER

3. Press CTRL+P, 
press ENTER

Other Ways
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2
• Click the Reply 

button on the 
Standard toolbar to 
open the RE: First 
Practice - Message 
window.

• When Outlook 
displays the 
Message 
window for 
the reply, if 
necessary, 
double-click the title 
bar to maximize the 
window.

• Type the e-mail reply 
(Figure 1–19).

Why is there RE: at 
the beginning of the 
Subject line and in 
the Title bar? 

The RE: indicates 
it is the reply, 
the subject of 
the message 
identifi es the title of 
the window, and Message indicates it is the Message window. 

Figure 1–19

message body
subject entry

Send button

carbon copy 
text box

RE: First Practice – 
Message window

e-mail 
reply

original 
e-mail 
message

3
• Click the Send button to send the 

message and return to the Inbox 
window (Figure 1–20).

What happened to the sent 
message? 

Outlook closed the Message 
window and stores the reply 
e-mail in the Outbox folder while 
it sends the message. Outlook 
then moves the message to the 
Sent Items folder. The original 
message in the message pane now 
shows an open envelope icon with 
an arrow to indicate a reply has 
been sent.

Figure 1–20

Inbox window

message 
selected

open envelope icon with 
arrow indicates message 
has been replied to

Q
&

A
Q

&
A

recipient’s 
name
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New Message Ribbon
The Ribbon for a reply message, new message, or forwarded message is similar to 

the Ribbon for a Word window (Figure 1–21). The Ribbon provides easy, central access 
to the tasks you perform while creating a message. The New Message Ribbon, in com-
parison to the Ribbon discussed earlier, consists of multiple tabs, groups, and commands. 
As in the previous Ribbon, each tab surrounds a collection of groups, and each group 
contains related commands. Many of the Ribbon commands will be inactive if the message 
format is Plain Text. To activate all of the commands, the message must be in HTML or 
Rich Text format. These formats are discussed later in this chapter.

When you open a new mail Message window, the Ribbon displays four top-level 
tabs: Message, Insert, Options, and Format Text. The Message tab, called the primary tab, 
contains the more frequently used commands. To display a different tab on the Ribbon, click 
the top-level tab. That is, to display the Insert tab, click Insert on the Ribbon. To return 
to the Message tab, click Message on the Ribbon. The tab currently displayed is called the 
active tab.

Commands on the Ribbon include buttons, boxes (text boxes, check boxes, etc.), and 
galleries (Figure 1–22). A gallery is a set of choices, often graphical, arranged in a grid or 
list. You can scroll through choices on an in-Ribbon gallery by clicking the gallery’s scroll 
arrows. Or, you can click a gallery’s More button to view more gallery options on the 
screen at a time. Some buttons and boxes have arrows that, when clicked, also display a 
gallery; others always cause a gallery to be displayed when clicked. Most galleries support 
live preview, which is a feature that allows you to point to a gallery choice and see its 
effect in the document — without actually selecting the choice.

Figure 1–22

contextual 
tabs

text boxbutton

More button button arrow

text box 
scroll arrows

gallery scroll 
arrows

in-Ribbon 
gallery

Figure 1–21

Message tab

Ribbon 

groups 

top-level tabs 
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To Change Message Formats

The following steps change the message format.
1
• With a new Message window 

active, click the Options tab 
(Figure 1–23).

2
• Click the appropriate command 

(Plain Text, HTML, or Rich Text) in 
the Format group.

Working with Incoming Messages   OUT 19

Message Formats
Outlook offers three message formats: Plain Text, HTML, and Rich Text, 

summarized in Table 1–2. 

Table 1–2 Message Formats

Message Format  Description

HTML HTML format is the default format used when you create a message in Outlook. 
HTML supports the inclusion of pictures and basic formatting, such as text formatting, 
numbering, bullets, and alignment. HTML is the recommended format for Internet 
mail because the most popular e-mail programs use it.

Plain Text Plain Text format is understood by all e-mail programs and is the most likely format to 
make it through a company’s virus-fi ltering program. Plain text does not support basic 
formatting, such as bold, italic, colored fonts, or other text formatting. It also does not 
support pictures displayed directly in the message.

Rich Text Rich Text Format (RTF) is a Microsoft format that only the latest versions of Microsoft 
Exchange and Outlook understand. RTF supports more formats than HTML or Plain 
Text, as well as linked objects and pictures.

Figure 1–23

Options tab

Format group

Replying to an E-Mail 
Message
Many e-mail users prefer 
to reply to a message 
without including the 
original e-mail message 
along with their response. 
To remove the original 
message from all e-mail 
replies, click Tools on the 
menu bar, click Options, 
and then click the E-mail 
Options button in the 
Preferences sheet of the 
Options dialog box. In 
the E-mail Options dialog 
box, select Do not include 
original message text in 
the When replying to a 
message list. 

B
T
W

Message Formatting
Changing the format 
of an e-mail message 
also can help prevent 
the possibility of virus 
infection. Many viruses 
are found in HTML 
formatted messages. 
To help protect against 
viruses, you can confi gure 
Outlook to display 
opened messages 
automatically in plain 
text. Click Options on 
the Tools menu and then 
click the E-mail Options 
button in the Preferences 
sheet of the Options 
dialog box, select Read 
all standard mail in plain 
text in the Message 
handling area.

B
T
W
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To Forward an E-Mail Message

You can forward an e-mail message to additional recipients. The following steps forward the Jose Quinteras 
e-mail message to the team’s coach.

1
• With the Inbox window active, 

click the Jose Quinteras message 
header in the message pane.

• Click the Forward button on the 
Standard toolbar (Figure 1–24).

Figure 1–24

Forward button

message 
heading selected

2
• When Outlook displays the 

Message window for the 
forwarded message, type 
kennymartin123@hotmail.com 
in the To text box as the recipient’s 
e-mail address. (If you are stepping 
through this task, use an actual 
e-mail address in the To text box.) 

• Enter the forwarding 
message in the message 
body (Figure 1–25).

3
• Click the Send button to forward 

the original message along with 
the new message to Kenny.

Figure 1–25

Send button

FW in Subject box and 
on title bar indicate 
message is a forward

Other Ways

1. Right-click message 
heading, click Forward 
on shortcut menu

2. Press CTRL+F

added 
message

original 
e-mail 
message
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To Delete an E-Mail Message

Deleting a message removes the e-mail message from the Inbox folder, saving disk space and making new mes-
sages easier to fi nd.The following steps delete the e-mail message from Jose Quinteras.

1
• With the Inbox window active, 

click the Jose Quinteras message 
heading in the message pane to 
select the message (Figure 1–26).

Why did the envelope icon for this 
message change to an open enve-
lope with a forward pointing blue 
arrow instead of the backward 
pointing purple arrow? 

The backward pointing purple 
arrow indicated that you replied 
to the message. The forward 
pointing blue arrow indicates that 
you have forwarded the message. 
The status of the envelope icon 
represents your last action with 
the message. 

Figure 1–26

Delete button

message 
forwarded icon

message 
heading selected

2
• Click the Delete button on the 

Standard toolbar to remove 
the message from your Inbox 
(Figure 1–27).

Is the message permanently 
deleted? 

Outlook moves the message to the 
Deleted Items folder. To perma-
nently delete an e-mail message 
from the Deleted Items folder, 
click the Deleted Items folder icon 
in the Mail Folders pane, select the 
message in the Deleted Items mes-
sage pane, click the Delete button, 
and then click the Yes button 
in the Microsoft Offi ce Outlook 
dialog box. 

Figure 1–27

e-mail message 
heading removed 
from Message pane

e-mail message 
moved to Deleted 
Items folder

Q
&

A
Q

&
A

Other Ways

1. Drag e-mail message to 
Deleted Items folder in 
Mail Folders pane

2.  On Edit menu, click 
Delete

3. Press CTRL+D

4. Click e-mail message, 
press DELETE key
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Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Figure 1–28

name of 
attached fi le

paper clip icon 
indicates attachment

message heading 
selected

To View a File Attachment

A paper clip icon in a message heading indicates that the message contains a fi le attachment. The message 
from Kenny Martin (see Figure 1–28) contains an attachment — in this case, a schedule for the team. The following 
steps open the message and view the contents of the fi le attachment.

1
• With the Inbox window active, 

double-click the Kenny Martin 
message heading in the 
Message pane (Figure 1–28).

COMP: Make sure arrows 
are pointing precisely where 
the Art MS indicates - they 
cannot even be slightly off

Figure 1–29

RE: This season’s schedule – 
Message window

fi le size

fi le name

message body
Excel 
worksheet icon

2

• If necessary, maximize the RE: 
This season’s schedule – Message 
window (Figure 1–29).
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3
• Double-click the 

Donner Schedule icon 
in the Attachments 
area to open the 
Donner Schedule 
Microsoft Excel fi le 
(Figure 1–30).

• If Outlook displays 
the Opening Mail 
Attachment dialog 
box, click the Open 
button.

What type of fi les 
can I open? 

File attachments can 
be any type of fi le; 
however, fi les can be 
viewed only if your 
computer has the 
appropriate soft-
ware. For example, 
if your computer 
does not have Excel 
installed, then you 
cannot view an Excel 
fi le attachment.

4
• After viewing the 

worksheet, click the 
Close button on the 
right side of the title 
bar in the Excel window to close the attachment and Excel.

• Click the Close button in the Message window.

Working with Outgoing Messages
Before composing a new mail message, you should create an e-mail signature to save time 
when sending messages.

An e-mail signature is a unique message automatically added to the end of an 
outgoing e-mail message. It can consist of text and/or pictures. The type of signature you 
add may depend on the recipient of the message. For messages to family and friends, a 
fi rst name may be suffi cient, while messages to business contacts may include your full 
name, address, telephone number, and other business information. Outlook allows you to 
create a different signature for each e-mail account created in Outlook.

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Figure 1–30

Donner Schedule – 
Microsoft Excel window

Close button

schedule

Other Ways

1. Double-click fi le 
attachment name in 
Reading Pane

2.  Click Save button 
in Opening Mail 
Attachments dialog box 
to save attachment to 
hard drive or portable 
storage device

3. On File menu point 
to Save Attachments 
to save attachment to 
hard drive or portable 
storage device

Q
&

A
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To Create and Insert an E-Mail Signature

The following steps create and insert an e-mail signature in an e-mail message. The signature will be used by 
Marcus in his role as team captain.

Figure 1–31

Options command

Tools menu

2
• Click Options on the Tools menu to 

display the Options dialog box.

• Click the Mail Format tab to 
display the Mail Format sheet 
(Figure 1–32).

Figure 1–32

Options 
dialog box

Signatures 
button

Mail Format tab

1
• With the Inbox window active, 

click Tools on the menu bar to dis-
play the Tools menu (Figure 1–31).
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4
• Click the New 

button to display 
the New Signature 
dialog box.

• When Outlook 
displays the New 
Signature dialog 
box, type Team in 
the ‘Type a name for 
this signature’ text 
box (Figure 1–34).

3
• Click the Signatures 

button to display 
the Signatures and 
Stationery dialog 
box (Figure 1–33).

Figure 1–33

Signatures and 
Stationery dialog box

New button

Figure 1–34

OK button

New Signature 
dialog box

Team entered 
as name of new 
signature

C6168_OUT_01.4c.indd   25C6168_OUT_01.4c.indd   25 3/7/07   10:45:43 AM3/7/07   10:45:43 AM



OUT 26   Outlook Chapter 1   Managing E-Mail and Contacts with Outlook

5
• Click the OK button.

• Click in the Edit 
signature area 
of the Signatures 
and Stationery 
dialog box and type 
Marcus Cook – 

Team Captain as 
the signature 
(Figure 1–35).

Figure 1–35

signature text 
for Marcus’ team 
captain signatureEdit signature 

area

Choose 
default 
signature 
area

6
• In the Choose default 

signature area of 
the Signatures and 
Stationery dialog 
box, select the appro-
priate e-mail account 
(if you are stepping 
through this project, 
ask your instructor 
for the appropriate 
e-mail account).

• If necessary, select 
Team in the New 
messages box and 
the Replies/forwards 
box to select it as 
the default signature 
(Figure 1–36).

7
• Click the OK button  

to close the Signatures 
and Stationery dialog 
box. Click OK in the Options dialog box to close the dialog box.

What do I do with my signature now that it is created? 

Your signature will be inserted automatically in all new messages as well as reply and forward
messages. You also can modify or remove your signatures at any time using the Signatures 
and Stationery dialog box. 

Figure 1–36

Delete button

account selected 
for this signature

Team selected as default 
signature for new messages, 
replies, and forwards

Other Ways

1. Press ALT+T, press O

OK button

Q
&

A
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2
• Click the New Mail 

Message button to open the 
Untitled – Message 
window (Figure 1–38).

E-Mail Signatures for Multiple Accounts
You can create unique signatures for different accounts by adding new signatures 

and selecting a different account in the Choose default signature area of the Signatures 
and Stationary dialog box (Figure 1–36). 

New Mail Messages
In addition to opening and reading, replying to, forwarding, and deleting e-mail 

messages, you will have many occasions to compose and send original e-mail messages. 
When you compose an e-mail message, you must know the e-mail address of the recipient 
of the message, enter a brief one-line subject that identifi es the purpose or contents of the 
message, and then type the message in the message body.

You also can format an e-mail message to enhance the appearance of the message. 
Formatting refers to changing the style, size, and color of the text document. 

To Compose an E-Mail Message

The following steps compose a formatted e-mail message to Kenny Martin with an attachment.

1
• With the Inbox window active, 

point to the New Mail Message 
button on the Standard toolbar 
(Figure 1–37).

Figure 1–37

New Mail 
Message button

Ribbon

Figure 1–38

message body

signature added 
automatically

Untitled – 
Message window

To, Cc, and 
Subject text boxes

E-Mail Signatures
Outlook allows you to 
add signatures to your 
e-mail messages that 
you create in Word 2007. 
Some of the advantages 
to creating them in Word 
is the ability to insert 
pictures and hyperlinks 
into the signature.

B
T
W
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3
• Type kennymartin123@ 
hotmail.com in the To text box, 
click the Subject text box, and then 
type Draft Practice Schedule 
in the Subject text box 
(Figure 1–39).

• Press the TAB key to move the 
insertion point into the message 
body area.

Figure 1–39

insertion point

destination
e-mail address

entry in Subject 
text box appears 
on title bar

subject of
e-mail message

4
• Type the e-mail 

message (Figure 1–40).

What if I make a 
mistake while typing 
a message? 

When you enter a 
message, you can use 
the DELETE key and 
BACKSPACE key to 
correct errors. 
If you are using 
Microsoft Word as 
your e-mail editor 
and you have the 
appropriate Spelling 
options selected, then 
the spell checker will 
fl ag the misspelled words 
with a red wavy line. Furthermore, the message will be spell checked before it is sent. 

Figure 1–40

HTML in title bar 
indicates current 
message format

message

Q
&

A
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1
• Highlight the text, DRAFT 

PRACTICE SCHEDULE, in the 
message body and then click the 
Format Text tab (Figure 1–41).

2
• Click the Center button in the 

Paragraph group on the Format 
Text tab to center the selected text 
(Figure 1–42).

Figure 1–42

text centered

Figure 1–41

Center button

DRAFT PRACTICE 
SCHEDULE selected

Format Text tab includes options 
to format text appearance

To Format an E-Mail Message

Outlook’s default message format is HTML, which allows you to customize text with numbering, bullets, 
alignment, signatures, and linking to Web pages. The following steps center the text, DRAFT PRACTICE 
SCHEDULE, change the font size to 36-point, and change the color of the text to red. A font size is measured 
in points. A point is equal to 1/72 of one inch in height. Thus a font size of 36 points is approximately one-half 
inch in height.
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3
• Click the Font Color button in the 

Font group on the Format Text tab 
to change the color of the selected 
text to red (Figure 1–43).

How do I pick a color other 
than red? 

To select a font color, click the box 
arrow on the Font Color button to 
display a color palette. Simply click 
a color on the palette to change 
the color of the text.

Figure 1–43

Font Color 
button

text changed 
to red

Q
&

A

4
• Click the Font Size box arrow in 

the Font group on the Format Text 
tab to display the Font Size list 
(Figure 1–44).

Figure 1–44

Font Size 
box arrow

Font Size list

Font Size box
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5
• Scroll down the Font Size list, click 

36, and then click the selected 
text to remove the selection 
(Figure 1–45).

Why do I have to select the entire 
text to change the format? 

Because centering is a paragraph 
format, you can simply click within 
the text, and then click the Center 
button. Font size, however, is a char-
acter format, so you must select the 
characters in the entire text before 
you select a new font size. 

Figure 1–45

36 in Font 
Size box

text formatted in 
36-point font size

insertion point

Q
&

A

To Attach a File to an E-Mail Message and Send the Message

Outlook allows you to attach almost any kind of fi le to your message. You may need to send a Word 
document, an Excel worksheet, a picture, or other type of fi le. The following steps attach the Draft Practice 
Schedule.xlsx fi le to the e-mail message.

1
• Click the Insert tab on 

the Ribbon and then 
click the Attach File 
button in the Include 
group to display the 
Insert File dialog box 
(Figure 1–46).

Figure 1–46

Look in 
box arrow

Attach File 
button

Insert File 
dialog box

Insert tab 
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2
• With your USB 

fl ash drive con-
nected to one of 
the computer’s USB 
ports, if necessary, 
click the Look in box 
arrow and then click 
UDISK 2.0 (E:) to 
select the USB fl ash 
drive, drive E in this 
case, in the Look 
in list as the device 
that contains 
the fi le. 

• Click Draft Practice 
Schedule in the 
Insert File dialog 
box (Figure 1–47).

Figure 1–47

Insert button

Draft Practice Schedule 
fi le selected as fi le 
attachment

3
• Click the Insert button in the 

Insert File dialog box to insert 
the fi le into the message 
(Figure 1–48).

What if I have more than one fi le 
to send? 

You can attach multiple 
documents to the same e-mail 
message. Simply perform the 
previous steps for each attach-
ment. Keep in mind, however, 
that some Internet service provid-
ers limit the total size of e-mail 
messages you can attach. You 
should keep the sum of the fi le 
sizes attached to an e-mail 
message to less than 1 MB.

4
• Click the Send button to send the 

message and close the Message 
window (Figure 1–48).

Figure 1–48

Attachment 
box appears

fi le name 
indicates 
attached 
Excel fi le

Send button

Q
&

A

File Attachments
Outlook allows other ways for a 
fi le to be inserted into a message. 
You can drag a fi le from any folder 
on your computer to a message, or 
you can copy and paste a fi le into 
a message as an attachment by 
right-clicking the fi le, clicking Copy 
on the shortcut menu, then in the 
Outlook message, clicking Paste on 
the Edit menu.
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Organizing E-Mail Messages
Keeping track of your incoming messages can be a challenge, especially if you receive a lot of 
mail. Two features that can help you organize your messages are the Category box and Follow 
Up fl ag, located to the right of the message headings. The Category box can be assigned one 
of six different default colors, or you can create your own categories with different colors. Color 
selection and the meaning of each color are entirely at the discretion of the user. For example, 
you could assign red to indicate a message from your boss, yellow could mean a message from 
your best friend, and purple may be a message from your parents.

The Follow Up fl ag can be assigned one of fi ve different fl ags, or you can customize 
your own Follow Up fl ag. These fl ags are used to remind you to follow up on an issue. When 
you select a fl ag, Outlook adds a reminder message in the Reading pane. Outlook also adds a 
task to the To-Do Bar.

To Categorize E-Mail Messages

Marcus would like to organize his messages. The following steps categorize, fl ag, and sort e-mail messages.

1
• With the Inbox 

window active, 
right-click the Kenny 
Martin message 
heading to display 
the message 
shortcut menu.

• Point to Categorize 
to display the 
Categories submenu 
(Figure 1–49).

Figure 1–49

Red Category 
command

Categories 
submenu

shortcut 
menu

Categorize 
command

message 
heading selected

Junk E-Mail Filters
A useful feature in Outlook is the Junk E-mail Filter. 
The fi lter is on by default. It automatically evaluates 
whether an unread message should be sent to the 
Junk E-mail folder. While you can confi gure the Junk 
E-mail Filter to your own personal settings, the default 
settings evaluate several factors, such as content, time 
the message was sent, and who sent the message. To 
change junk e-mail settings, click Options on the Tools 
menu, and then click the Junk E-mail button in the 
Preferences sheet of the Options dialog box. Make the 
preferred changes in the Junk E-mail Options dialog 
box. Note that the Junk E-mail folder is not available if 
you use an Exchange Server e-mail account.

B
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2
• Click the Red Category command 

on the Categories submenu. If the 
Rename Category dialog box 
appears, click No.

• Repeat Steps 1 and 2 to categorize 
the remaining messages in the 
message pane (Figure 1–50).

Figure 1–50

category description 
in Reading pane

all messages 
categorized

Other Ways

1. Right-click Categorize 
box, click appropriate 
category color

2. On Actions menu, 
point to Categorize, 
click appropriate 
category color

3. Click the Category 
button on the 
Standard toolbar, 
click appropriate 
category color

4. Press ALT+A, press I

To Flag E-Mail Messages

The following steps mark a message with a fl ag that indicates the message needs to be dealt with today.

1
• With the Inbox window active, 

right-click the Kenny Martin 
message heading to display the 
message shortcut menu 
(Figure 1–51).

• Point to Follow Up to display the 
Follow Up submenu (Figure 1–51).

Figure 1–51

Today 
command

Follow Up 
command

shortcut menumessage 
heading selected

Follow up 
submenufl ag icon
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2
• Click the Today command on the 

Follow Up submenu to assign a 
Follow Up fl ag with today as the 
due date. 

• Repeat Steps 1 and 2 to add Follow 
Up fl ags to the remaining messages 
in the message pane (Figure 1–52).

• Select different fl ags as necessary.

What does the Follow Up message 
in the Reading pane mean? 

You can select from fi ve default 
Follow Up fl ags. The message in 
the Reading pane corresponds to 
that selection and assigns a Start 
date and Due date to the selection 
(today, tomorrow, this week, and 
next week).

Figure 1–52

all messages 
fl agged for 
follow upQ

&
A

1. Right-click Follow Up fl ag, 
click appropriate fl ag

2. On Actions menu, point 
to Follow Up, click 
appropriate fl ag

3. Click the Follow Up button 
on the Standard toolbar, 
click appropriate fl ag

4. Press ALT+A, press U

Other Ways

To Sort E-Mail Messages by Category Color

After categorizing and fl agging the appropriate messages, you can sort the messages by category color. The 
following steps sort the messages by category color.

1
• With the Inbox window active, 

click View on the menu bar to 
open the View menu. Point to 
Arrange By to display the Arrange 
By submenu (Figure 1–53).

Arrange By 
submenu

View menu

Custom command

Categories command

Arrange By 
command

Figure 1–53

Date command
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2
• Click Categories on the Arrange By 

submenu to sort the messages by 
Category (Figure 1–54).

3
• Return to the previous view by 

repeating Step 1 and then clicking 
Date on the Arrange By submenu.

Figure 1–54

arranged by category 

messages sorted 
by color in 
message pane

Other Ways

1. Press ALT+V, press A, 
press E

To Create and Apply a View Filter

The following steps create and apply a view fi lter to show only messages from Kenny Martin.

1
• With the Inbox 

window active, 
click View on the 
menu bar.

• Point to Arrange 
By on the View 
menu and then 
click Custom on the 
Arrange By sub-
menu to display the 
Customize View: 
Messages dialog box 
(Figure 1–55).

Filter button

Customize View: 
Messages dialog box

Figure 1–55

View menu
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OK button

Clear All button

Filter dialog box

Kenny Martin 
entered in From 
text box

Figure 1–56

2
• Click the Filter button to display 

the Filter dialog box.

• Click the From text box 
(Figure 1–56).

• Type Kenny Martin in the From 
text box to specify that only e-mail 
messages from Kenny Martin are 
to appear.

3
• Click the OK button in the Filter 

dialog box and the Customize 
View: Message dialog box to close 
both boxes and apply the view 
fi lter (Figure 1–57).

How do I know that my other 
messages have not been deleted? 

Outlook displays a message on the 
status bar and the Inbox pane title 
bar when a view fi lter is applied 
to a selected folder. It also shows 
the total number of messages 
remaining in the Inbox folder on 
the status bar. 

4
• Repeat Steps 1 and 2 to display 

the Filter dialog box.

• Click the Clear All 
button in the Filter 
dialog box to remove 
the view fi lter.

• Close the Filter and 
Customize View: Message dialog 
boxes.

total number of 
messages in Inbox

(Filter Applied) 
message appears 
on title bar

Filter Applied 
message on 
status bar

Figure 1–57

only messages 
meeting fi lter 
criteria appear in 
message paneQ

&
A
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E-Mail Message Options
Outlook offers several ways in which you can customize your e-mail. You can either 

customize Outlook to treat all messages in the same manner, or you can customize a 
single message. Among the options available through Outlook are setting e-mail message 
importance and sensitivity. Setting message importance will indicate to the recipient the 
level of importance you have given to the message. For example, if you set the importance 
at high, a red exclamation point icon will appear with the message heading (Figure 1–58). 
Setting message sensitivity indicates whether the message is personal, private, or confi -
dential. A message banner indicating the sensitivity of the message appears in the Reading 
pane below the sender’s name in the message header, as shown in Figure 1–58.

Along with setting importance and sensitivity, Outlook also offers several delivery 
options. You can have replies to your message automatically forwarded, save sent messages 
in a location of your choice (default is Sent Items folder), or delay delivering a message 
until a specifi ed date and time.

New Mail 
Message button

note indicating 
message is private

exclamation point 
icon indicates high 
importance

Figure 1–58

To Set Message Importance, Sensitivity, and Delivery Options in a Single Message

The following steps set message importance, sensitivity, and delivery options in a single message.

1
• With the Inbox 

window active, 
click the New Mail 
Message button 
on the Standard 
toolbar.

• Enter the message 
information 
(Figure 1–59).

Options Dialog 
Box Launcher

recipient’s address

subject of 
message

Figure 1–59

new message in 
message body
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2
• Click the Options Dialog Box 

Launcher on the Ribbon to display 
the Message Options dialog box 
(Figure 1–60).

Importance 
box arrow

Sensitivity 
box arrow

Do not deliver 
before check box

Message Options 
dialog box

Security Settings 
button

Figure 1–60

3
• Click the Importance box 

arrow and then select High in the 
Importance list.

• Click the Sensitivity box arrow 
and then select Private in the 
Sensitivity list.

• Click the ‘Do not deliver before‘ 
check box in the Delivery options 
area to select it.

• Select January 14, 2008 in the 
calendar and 12:00 PM as the time 
in the respective delivery boxes 
(Figure 1–61).

Close button

check box 
selected

Private selected 
in Sensitivity box

High selected in 
Importance box

January 14, 2008 and 
12:00 PM selected 
for delivery time

Figure 1–61
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4
• Click the Close 

button to close the 
dialog box.

How do I know that 
my settings have 
been applied to this 
message? 

Notice that the High 
Importance button 
on the Ribbon is 
highlighted 
(Figure 1–62). While 
you cannot see it, 
the recipient of the 
message will receive 
the message with 
a red exclamation 
point icon and the message heading indicating the e-mail is private, like the one shown in Figure 1–58 on page OUT 38.

5
• Click the Send button to send the message.

What does Outlook do with the message while it is waiting for the specifi ed date and time to send the message? 

Outlook stores the message in the Outbox folder until the specifi ed date and time arrive. At that time, the message will 
be sent.  

Send button

High Importance 
button highlighted 

Figure 1–62

To Change the Default Level of Importance and Sensitivity

Outlook allows you to change the default level for either or both of these options. The following steps change 
the default level of importance and sensitivity for all outgoing messages.

1
• With the Inbox window active, 

click Tools on the menu bar and 
then click Options on the Tools 
menu to display the Options 
dialog box (Figure 1–63).

Preferences tab
E-mail Options 
button

Options 
dialog box

Figure 1–63

Q
&

A
Q

&
A
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2
• In the Preferences sheet, click the 

E-mail Options button to display 
the E-mail Options dialog box 
(Figure 1–64).

• Click the Advanced E-mail Options 
button to open the Advanced 
E-mail Options dialog box.

E-mail Options 
dialog box

Advanced E-mail 
Options button

Figure 1–64

3
• Click the Set importance box ar-

row to display the importance 
options (Figure 1–65).

• Select High in the Set 
importance list.

OK button

Set importance 
box arrow

Set importance box

Set importance 
list

Advanced E-mail 
Options dialog box

Figure 1–65
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4
• Click the Set sensitivity box arrow 

to display the sensitivity options.

• Select Private in the Set sensitivity 
list (Figure 1–66).

5
• Click the OK button in all three 

open dialog boxes to close them 
and return to the Inbox window.

Private selected in 
Set sensitivity box

High selected in Set 
importance box

Figure 1–66

Other Ways

1. Press ALT+T, press O

Rules
Another way to manage 
e-mail messages is to 
have Outlook apply rules 
when receiving and/or 
sending messages. Using 
rules, you can have 
messages automatically 
forwarded, categorized, 
fl agged for follow up, or 
apply other options. To 
create a rule, click Rules 
and Alerts on the Tools 
menu, and then click the 
New Rule button in the 
E-mail Rules sheet of 
the Rules and Alerts 
dialog box.

B
T
W
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Large Mail 
folder

Categorized 
Mail folder

Mail Folders 
pane

Categorized Mail 
message pane

Figure 1–67

Search 
Folders folder

Unread 
Mail folder

categorized 
message headings

Search Folders 
Outlook offers a feature called the Search Folders folder in the Mail Folders pane 

(Figure 1–67). The Search Folders folder includes a group of folders that allows you to 
group and view your messages quickly in one of three ways: (1) Categorized Mail, (2) Large 
Mail, and (3) Unread Mail. Categorized Mail messages are messages to which you have 
assigned a category. These messages are sorted by color. Large Mail messages are messages 
containing very large fi le attachments. These messages are grouped by size: Large (100 to 
500 KB), Very Large (500 KB to 1 MB), and Huge (1 to 5 MB). Unread Mail comprises 
messages that have not been opened or have not been marked as read even though you 
may have read them in the Reading pane. Figure 1–67 shows messages in the Categorized 
Mail folder.

Security Settings
Click the Security Settings 
button (Figure 1–60 on 
page OUT 39) opens a 
dialog box that allows 
you to apply certain 
security restrictions 
on a message, such as 
encrypting the message 
or adding a digital 
signature.

B
T
W
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To Create a Personal Folder

The following steps create a personal folder for Marcus Cook.

1
• Click the Contacts 

button in the Navigation Pane to 
open the Contacts window.

• When Outlook displays the 
Contacts window, right-click 
Contacts in the My Contacts pane 
to display the Contacts shortcut 
menu (Figure 1–68).

Using Contacts
The Contacts component of Outlook allows you to store information about individuals and 
companies. People with whom you communicate for school, business, or personal reasons 
are your contacts. To help organize information about personal contacts, some people keep 
names, addresses, and telephone numbers in business card fi les and address books. With the 
Outlook Contacts component, you can create and maintain important contact information in 
a contact list, which is stored in the Contacts folder. Your contact list is like an electronic ad-
dress book that allows you to store names, addresses, e-mail addresses, and more. Once you 
have entered the information, you can retrieve, sort, edit, organize, or print your contact list. 
Outlook also includes a Find option that lets you search for a contact name in your address 
book while you are using the Calendar, Inbox, or other Outlook components.

When the Contacts folder is open, information about each contact appears on a 
business card in the default Business Cards view. Each card includes fi elds for name, 
address, and multiple telephone numbers (home, work, cellular, and so on), e-mail, and Web 
page addresses. You can choose which fi elds are displayed on the cards using the View menu.

Previously, an e-mail message was composed, signed, formatted, and sent to Kenny 
Martin. Kenny’s e-mail address was typed into the To text box. The following sections show 
how to (1) create a personal folder; (2) create a contact list; (3) edit contact information; 
(4) print contact information; and (5) send an e-mail to a contact.

Standard 
toolbar

New Folder 
command

Contacts 
shortcut menu

Contacts window

Contacts 
folder

My Contacts 
pane

Contacts 
button

Figure 1–68
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2
• Click New Folder on 

the Contacts shortcut 
menu to display the 
Create New Folder 
dialog box. Type 
Marcus' Contacts 
in the Name text box 
(Figure 1–69).

• If necessary, select 
Contact Items in the 
Folder contains list.

• Click Contacts in 
the Select where to 
place the folder list.

Name text box

Folder contains 
text box

Contacts folder 
selected

Create New Folder 
dialog box

Figure 1–69

list of folders 
and subfolders

3
• Click the OK button 

to close the Create 
New Folder 
dialog box.

• In the Contacts 
window, click 
Marcus’ Contacts in 
the My Contacts list 
(Figure 1–70). double-click 

Contacts pane to 
create new contact

Contacts pane 
blank except for 
Outlook message

Contacts pane titled 
Marcus’ Contacts

My 
Contacts 
pane

Marcus’ 
Contacts 
folder

New Contact 
button

Figure 1–70

1. On File menu point to 
New, click Folder on New 
submenu

2. On File menu, point to 
Folder, click New Folder on 
Folder submenu

3. Press CTRL+SHIFT+E

Other Ways

Contacts displayed 
on title bars identify 
active component 
of Outlook

OK button
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Figure 1–71 illustrates the Standard toolbar located below the menu bar in the Con-
tacts window.

Next, you will create a contact list using the information included in Table 1–3.

Table 1–3 Contact Information 

Name Telephone Address E-Mail Address

Kenny Martin (937) 555-4120 8465 W. 63rd St.
Donner, OH 44772

kennymartin123@hotmail.com

Jose Quinteras (937) 555-7539 8868 Ashwood Lane
Donner, OH 44772

josequinteras123@hotmail.com

Kelly Shurpa (937) 555-9823 214 W. Lincoln Ave.
Donner, OH 44772

kshurpa123@hotmail.com

Matt Tartan (937) 555-0258 5246 Brookfi eld Ct.
Donner, OH 44772

mtartan123@hotmail.com

Jim Osmont (937) 555-6211 9812 River Rd.
Donner, OH 44772

josmont123@hotmail.com

Cale Freeman (937) 555-3080 7894 Forrest View Lane
Donner, OH 44772

calefreeman123@hotmail.com

Kyle Baker (937) 555-5279 7892 Buckingham Drive
Donner, OH 44772

kylebaker101@hotmail.com

Ryan Hunt (937) 555-1683 8792 Edgewater Lane
Donner, OH 44772

ryanhunt123@hotmail.com

Luke Davis (937) 555-2794 6776 Maplewood Blvd.
Donner, OH 44772

lukedavis101@hotmail.com

Trevor Walker (937) 555-8805 4476 Maplewood Blvd.
Donner, OH 44772

trevwalker123@hotmail.com

Kevin Anderson (937) 555-6309 1021 Ward Rd.
Donner, OH 44772

kevanderson123@hotmail.com 

Jake Nunan (937) 555-2148 8924 65th Street
Donner, OH 4477

jakenunan123@hotmail.com

Figure 1–71

Move to 
Folder

Delete

CategoriesNew Contact

Print Dial

New Message 
to Contact

Address 
Book

Toolbar 
Options

Microsoft Offi ce 
Outlook Help

Follow Up Find a 
Contact box
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To Create a Contact List

The following steps create a contact list.

1
• With the Contacts 

window active and 
Marcus’ Contacts 
folder selected, click 
the New Contact but-
ton on the Standard 
toolbar (Figure 1–70 
on page OUT 45) to 
open the Untitled-
Contact window. If 
necessary, maximize 
the window.

• Type Kenny Martin 
in the Full Name text 
box (Figure 1–72).

• Click the Home text 
box in the Phone 
numbers area.

Home text box

E-mail text box

Addresses 
box arrow

Business text box

Addresses 
text box

title bar displays 
contact’s name

File as box 
automatically 
fi lled in

business card 
automatically fi lls in as 
information is entered

Figure 1–72

Full Name 
text box

Ribbon

2
• Type 9375554120 as 

the home telephone 
number.

• Click the Addresses 
box arrow and 
select Home.

• Click the text box in 
the Addresses area, 
type 8465 W. 63rd 
St. and then press 
the ENTER key.

• Type Donner, OH 
44772 to complete 
the address entry.

• Click the E-mail 
text box.

• Type 
kennymartin123 

@hotmail.com as 
the e-mail address 
and then press 
the TAB key to 
complete the 
contact information 
for Kenny Martin 
(Figure 1–73).

Details button
Save & Close 
button

check box 
selected by 
default

business card 
containing all 
entered information

telephone 
number 
automatically 
formatted

Figure 1–73

contact information 
entered into 
appropriate text boxes
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3
• Click the Save & Close button on 

the Ribbon to display the Marcus’ 
Contacts window with the Kenny 
Martin business card in the 
Marcus’ Contacts pane 
(Figure 1–74).

business card 
for fi rst contact

Business Cards 
option button 
selected

Figure 1–74

4
• Click the New 

Contact button on 
the Standard toolbar.

• Repeat Steps 2 
through 
4 to enter 
the 11 
remaining 
contacts in Table 1–3 
(Figure 1–75). 

Is it possible to store 
information 
different from 
what is shown 
in the Contact 
window? 

By clicking the Details 
command in the 
Show group on the 
Ribbon (Figure 1–73 
on page OUT 47), 
you can enter a 
contact’s department, 
manager’s name, 
nickname, and 
birthday information.

New Contact 
button

business card

Current 
View pane

current view 
is Business 
Cards

indicates range of 
contacts that appear 
alphabetically

Figure 1–75

contacts 
entered

1. On File menu point to 
New, click Contact on New 
submenu

2. On Actions menu click New 
Contact

3. Press CTRL+SHIFT+C

Other Ways

Q
&

A

Contact 
Index
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To Change the View and Sort the Contact List

The following steps change the view from Business Cards to Phone List, sort the contact list in descending 
sequence, and then change back to Business Cards view.

1
• With the Marcus’ 

Contacts – Microsoft 
Outlook window 
active, click Phone 
List in the Current 
View pane of the 
Navigation Pane.

• With the Phone 
List in ascending 
sequence by the File 
As fi eld, click the File 
As column heading 
in the Contacts pane 
to display the contact 
list in descending 
sequence by last 
name (Figure 1–76).

columns to 
sort by

Phone List 
selected

File As column 
heading

Business Cards 
deselected when 
Phone List selected

arrow pointing up 
indicates ascending 
sequence; click to 
change sequence

Figure 1–76

Phone List view

2
• After reviewing the contact list 

in Phone List view, click Business 
Cards in the Current View pane in 
the Navigation Pane to return to 
Business Cards view.

Are there other ways to sort 
Outlook information? 

If you right-click a column heading 
in any Outlook component 
and point to the Arrange By com-
mand on the shortcut menu 
(Figure 1–77), you can see the 
Arrange By commands. 

Figure 1–77

shortcut menu

Arrange By 
command

Arrange By 
submenu

fi elds to 
arrange by

Q
&

A
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2
• Outlook opens 

the Kelly 
Shurpa – Contact 
window 
(Figure 1–79).

• Click the Close 
button to return to 
Business Card view.

What if there is 
more than one 
contact starting with 
the letters, shu? 

If more than one 
contact with the 
starting letters, 
shu, exists, Outlook 
displays a Choose 
Contact dialog box 
with the list of all 
contacts containing 
the letters, shu. You 
can then select the 
appropriate contact 
from the Choose 
Contact dialog box. 

To Find a Contact

A contact record was created for Kelly Shurpa. This record can be found easily by using the Find a Contact 
box to type a part of the contact name as shown in the following steps.

1
• Click the Find a Contact box on the 

Standard toolbar (Figure 1–78). 

• Type shu in the text box.

• Press the ENTER key to start the 
search process.

Find a 
Contact box

Figure 1–78

Kelly Shurpa 
contact record

Figure 1–79

Close button

Other Ways

1. On Tools menu point to 
Find, click Find on Find 
submenu

2. Press CTRL+SHIFT+F

Q
&

A
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To Organize Contacts

To help manage your contacts further, the contact list can be categorized and sorted using Outlook’s default 
color categories, or using your own categories to group contacts by company, department, a particular project, a 
specifi c class, and so on. You also can sort by any part of the address; for example, you can sort by postal code 
for bulk mailings. The following steps assign the baseball players as a contact category with a color 
designation.

1
• Click Tools on the 

menu bar and then 
click Organize on 
the Tools menu.

• Click the name 
bar of the Kevin 
Anderson contact 
record.

• Hold down the CTRL 
key and then click 
the name bars of 
Cale Freeman and 
Ryan Hunt.

• Release the CTRL key.

• Click the ‘Add 
contacts selected 
below to’ box arrow 
to display a list 
of categories 
(Figure 1–80).

• Click Blue Category 
in the list.

name bar 

Blue category

Add contacts 
selected below 
to box

categories list

Ways to Organize 
Marcus’ Contacts 
dialog box

Figure 1–80

Tools command

three contacts 
selected

2
• Click the Add button 

to add the selected 
records to the 
Blue Category 
(Figure 1–81).

Done! message indicates 
that contacts were 
categorized

Create a new 
category called box

Ways to Organize 
Marcus’ Contacts dialog 
box Close button

Figure 1–81

Add button

other ways 
to organize a 
contact list

Other Ways

1. Press ALT+T, press Z
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2
• Type Blue 
Category in the 
Instant Search text 
box and then press 
the ENTER key to 
display the three 
contacts that belong 
to the Blue Category 
(Figure 1–83).

• After viewing the 
contacts in the Blue 
Category, click the 
Clear Search button 
to return to the full 
Contacts window.

To Display the Contacts in a Category

The following steps use the Instant Search command to display contacts within a certain category.

1
• With the Contacts 

window active, click 
Tools on the menu 
bar and then point 
to Instant Search to 
display the Instant 
Search submenu 
(Figure 1–82).

• Click Instant Search 
on the Instant Search 
submenu.

Instant Search 
command

Instant Search 
commandTools menu

Instant Search 
text box specifi es 
the category on 
which to search

Figure 1–82

Instant Search 
submenu

Clear Search button

Blue Category entered in 
Instant Search text box

Figure 1–83

three contacts 
in Blue category

Other Ways

1. Press CTRL+E

2. Press ALT+T, press I
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To Preview and Print the Contact List

The following steps preview and print the entire contact list.

1
• With the Contacts 

window active, 
click the Print but-
ton on the Standard 
toolbar to display 
the Print dialog box 
(Figure 1–84).

• Click the Preview 
button to display 
a preview of 
the printout 
(Figure 1–85).

OK button

Print button

Preview button

Page Setup 
button

Copies area

Print dialog box

available 
print styles

Figure 1–84

print all or only 
selected contacts

Contacts
You can organize 
contacts from one or 
more Contacts folders in 
a personal distribution 
list. Outlook also detects 
duplicates and provides 
the option to merge the 
new information with 
the existing contact 
entry. You also can fi lter 
your contact list and then 
use the fi ltered list to 
begin a mail merge from 
Outlook.

B
T
W
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2
• After viewing the preview of 

the printed contacts list, click the 
Close button.

• If the preview is acceptable, ready 
the printer.

• Click the Print button on the 
Standard toolbar.

• When Outlook displays the Print 
dialog box, click the OK button.

What if I want to print just a 
single category of contacts? 

If you display a category of 
contacts and then click the Print 
button, Outlook will print only 
the contacts in that category. 

Close button

preview of 
printout

Figure 1–85

Other Ways

1. On File menu click Print

2. On File menu click Print 
Preview, click Print 
button in Print Preview 
window

3. Press CTRL+P

Q
&

A

Business Contact Manager
Outlook 2007 with Business Contact Manager 
offers complete small business contact 
management capabilities to Outlook 2007. It 
allows you to organize customer and prospect 
information, manage sales and marketing 
activities, develop and track marketing 
activities, and centralize project information 
in one location. Among the capabilities 
of Business Contact Manager are tools for 
creating targeted mailing lists, personalizing 
and distributing print and e-mail marketing 
materials, and tracking results.

B
T
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To Use the Contact List to Address an E-Mail Message

The following steps use the contact list to address an e-mail message to Matt Tartan.

1
• Click the Mail button in the 

Navigation Pane to display the 
Inbox window.

• Click the New Mail Message 
button on the Standard toolbar 
to display the Untitled – Message 
window (Figure 1–86).

• When Outlook displays the 
Untitled – Message window, if 
necessary, double-click its title bar 
to maximize it.

To button

signature

insertion point

Untitled – Message 
window

Figure 1–86

To, Cc, and 
Subject text boxes

2
• Click the To button to display 

the Select Names dialog box 
(Figure 1–87). 

• Click the Address Book box arrow.
Address Book 
box arrow

Select Names 
dialog box

list of folders 
containing 
contacts

Figure 1–87
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3
• Click Marcus’ Contacts in the list.

• Click the Matt Tartan entry in 
the contact list (Figure 1–88).

To button

Matt 
Tartan 
entry 

contact list

Figure 1–88

list of contacts in the 
Marcus’ Contacts folder 
with e-mail addresses

4
• Click the To button in the 

Message Recipients area to 
add Matt Tartan as the message 
recipient (Figure 1–89).

OK button

Cc button

Bcc button

Matt Tartan entry 
in To text box

Figure 1–89
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6
• Type the message 

(Figure 1–91).

• Click the Send button 
to send the mes-
sage and close the 
Message window.

Can I add more than 
one name to the To 
text box? 

You can 
add as 
many 
names as 
you want 
to the To text box. 
You also can add 
names to the Cc text 
box. If you do not 
want those listed in the 
To text box or Cc text box to know you sent a copy to someone else, send a blind copy by 
adding the name to the Bcc text box. 

5
• Click the OK button to close the 

Select Names dialog box.

• Click the Subject text box and then 
type Carwash Fund-raiser as 
the entry (Figure 1–90).

• Press the TAB key to move the cur-
sor to the message area.

Matt Tartan 
entry

subject typed in 
Subject text box

subject displayed 
as window title

Figure 1–90

Figure 1–91

Send 
button

e-mail 
message

Other Ways

1. Click Address Book 
command on Message 
window Ribbon

Q
&

A
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1
• With the Contacts window active, 

click the New Contact button ar-
row on the Standard toolbar to 
display the New Contact menu 
(Figure 1–92).

Distribution List 
command

New Contact 
button arrow

New Contact menu

Figure 1–92

2
• Click Distribution 

List to display 
the Untitled – 
Distribution List win-
dow. Type Chemistry 
Lab Group in the 
Name text box, and 
then click the Select 
Members button on 
the Ribbon to display 
the Select Members 
dialog box.

• Click the Address 
Book box arrow 
and click Marcus’ 
Contacts.

• Select Jake Nunan 
and then click the 
Members button 
to add Jake to the 
Chemistry Lab Group 
distribution list.

• Add Kyle Baker 
and Trevor Walker 
to the list in the 
same manner 
(Figure 1–93).

Members 
button

OK button

Members 
button

Address Book 
box arrow

Select Members 
dialog box

name of 
distribution list

contacts 
from which 
to select

Figure 1–93

members list  
(distribution list)

To Create a Distribution List

Outlook can send the same message to a group of recipients using a distribution list. The following steps 
create a distribution list titled Chemistry Lab Group that includes four members from Marcus’ Contacts list.

Select Members 
button
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5
• Click the Address Book button on 

the Standard toolbar to display 
the Address Book dialog box.

• Select Marcus’ Contacts in the 
Address Book list to display the 
contact list, which now includes 
the Chemistry Lab Group 
distribution list (Figure 1–95).

6
• Click the Close button to close the 

the Address Book window.

Can I edit or add to a distribution 
list after it is saved? 

Yes. The Chemistry Lab Group 
– Distribution List window in 
Figure 1–94 includes two com-
mands in the Members group on 
the Ribbon that are useful for modifying a distribution list. The Add New command lets you add a contact that is not 
already in the distribution list. The Remove command lets you delete names from the distribution list, although they 
remain in your Outlook contact list.

3
• Click the OK button to close the 

Select Members dialog box and 
display the Chemistry Lab Group 
– Distribution List window show-
ing the members of the Chemistry 
Lab Group distribution list 
(Figure 1–94).

4
• Click the Save & Close 

command on the Ribbon to 
close the Chemistry Lab Group 
– Distribution List window and 
activate the Contacts window.

Remove 
command

Add New 
command

Save & Close 
command

Figure 1–94

contacts selected 
for inclusion in 
distribution list

Close button

Address Book 
button

Address Book: 
Marcus’ Contacts 
window

Chemistry Lab  
Group distribution 
list added to 
Marcus’ contact list

Figure 1–95

Q
&

A

The Internet
Outlook automatically creates 
a hyperlink when you type 
a Web page address or an 
e-mail address in the text box 
of a Contact window. If you 
are connected to an Internet 
browser, you can click the 
hyperlink to go to the 
destination quickly or send an 
e-mail message.

B
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Saving Outlook Information in Different Formats
You can save Outlook fi les on external storage devices in several formats. For example, 

you can save messages and contact lists in text format, which can be read or copied into 
other applications.

To Save a Contact List as a Text File and Display it in WordPad

The following steps save a contact list on a USB fl ash drive as a text fi le and display it in WordPad.

1
• Connect the USB 

fl ash drive contain-
ing the Data Files for 
Students to one 
of the computer’s 
USB ports.

• With the Contacts 
window active, click 
the name bar of the 
fi rst contact in the 
contact list.

• Press CTRL+A to select 
all the contacts.

• Click File on the 
menu bar to display 
the File menu 
(Figure 1–96).

Save As 
command

File menu

Figure 1–96

all contacts 
selected

2
• Click Save As on 

the File menu to 
display the Save As 
dialog box.

• Type Marcus' 
Contacts in the File 
name text box.

• If necessary, select 
Text Only in the Save 
as type box.

• Click the Save in 
box arrow and then 
select UDISK 2.0 (E:) 
(Figure 1–97). (Your 
USB fl ash drive may 
have a different 
name and letter.)

Save button
fi le name

save as a text fi le

drive E 
selected

Save As 
dialog box

Figure 1–97

back button, select 
folders, delete, 
and perform 
other tasks

commonly used 
locations
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3
• Click the Save button in the Save 

As dialog box.

• Click the Start button on the 
Windows taskbar, point to All 
Programs on the Start menu, point 
to Accessories on the All Programs 
submenu, and then click WordPad 
on the Accessories submenu to 
open the Wordpad text editor.

• When WordPad starts, 
click the Maximize 
button on the title 
bar, click File on the 
menu bar, and then 
click Open.

• When WordPad displays the Open 
dialog box, click the Files of type 
box arrow, select All Files, click 
the Look in box arrow, and then 
click UDISK 2.0 (E:) (your USB fl ash 
drive may have a different name 
and letter) in the Look in list.

• Double-click Marcus’ Contacts to 
display Marcus’ Contacts as a text 
fi le (Figure 1–98).

4
• After viewing the text fi le, click 

the WordPad Close button.

WordPad window

contact list 
viewed as a 
text fi le

Figure 1–98

Tracking Activities 
When you are dealing with several contacts, it can be useful to have all associated 

e-mails, documents, or other items related to a contact available quickly. Outlook makes 
these items accessible through the Activities command in the Show group, located on the 
Contact window Ribbon. Clicking this command for a contact opens a list of all items 
related to that contact. Outlook searches for items linked only to the contact in the main 
Outlook folders (Contacts, Calendar, etc.); however, you can create and add new folders to 
be searched.
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To Track Activities for a Contact

The following steps track the activities of Kenny Martin.

1
• With the Contacts 

window active, 
double-click the 
Kenny Martin 
contact heading.

• Click the Activities 
command on the 
Ribbon to display 
the Activities sheet 
showing a list of 
items related to 
Kenny Martin 
(Figure 1–99).

Close button

Activities 
command

Contact window

Figure 1–99

list of items 
related to contact

location 
of items

Outlook Help
At any time while using Outlook, you can fi nd answers to questions and display information 
about various topics through Outlook Help. The Help features can increase your produc-
tivity and reduce your frustrations by minimizing the time you spend learning how to use 
Outlook. 

This section introduces you to Outlook Help. Additional information about using 
Outlook Help is available in Appendix C. 

Outlook Help 
The best way to 
become familiar with 
Outlook Help is to use 
it. Appendix C includes 
detailed information 
about Outlook Help and 
exercises that will help 
you gain confi dence in 
using it.

B
T
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To Search for Outlook Help

Using Outlook Help, you can search for information based on phrases such as “send an e-mail message” or 
“format text,” or key terms such as “copy,” “save,” or “format.” Outlook Help responds with a list of search results 
displayed as links to a variety of resources. The following steps, which use Outlook Help to search for information 
about selecting text, assume you are connected to the Internet.

1
• Click the Microsoft Offi ce Outlook 

Help button on the Standard 
toolbar to open the Outlook 
Help window.

• Type format text in the ‘Type 
words to search for’ text box at 
the top of the Outlook Help 
window (Figure 1–100).

Maximize 
button

Outlook Help window 
allows you to search for 
information based on 
phrases or key terms

Figure 1–100

Type words 
to search for 
text box

Microsoft Offi ce 
Outlook Help button
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2
• Press the ENTER key 

to display the 
search results. 

• Click the Maximize 
button on the 
Outlook Help 
window title bar 
to maximize the 
Help window 
(Figure 1–101).

Where is the 
Contacts window? 

Outlook is open in 
the background, but 
the Outlook Help 
window is over-
laid on top of the 
Microsoft Outlook 
window. When the 
Outlook Help win-
dow is closed, the 
Contacts window 
will reappear. 

Q
&

A
Outlook 
Help window 
maximized

fi rst 25 results 
of search are 
displayed

clicking these links 
will display other 
pages with links 
about selecting text

Figure 1–101

Microsoft Outlook 
window in 
background

3
• Click the Apply bold, 

italic, or under-
line formatting to 
text link to display 
information regard-
ing formatting text 
(Figure 1–102).

What is the purpose 
of the buttons at the 
top of the Outlook 
Help window? 

Use the buttons in 
the upper-left corner 
of the Outlook Help 
window to navigate 
through the Help 
system, change the 
display, show the 
Outlook Help table 
of contents, and 
print the contents of the 
window. 

4
• Click the Close button on the Outlook Help window title bar to close the Outlook Help 

window and redisplay the Contacts window.

Print button

Figure 1–102

Back, Forward, 
Stop, Refresh, and 
Home buttons

Close button

Other Ways

1. Press F1 

Q
&

A

click to display text 
formatting information
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Chapter Summary
In this chapter you have learned how to use Outlook to open, read, print, reply to, forward, delete, sign, compose, 
format, and send e-mail messages. You opened and viewed fi le attachments as well as attached a fi le to an e-mail 
message. You learned how to categorize, fl ag, sort, and set importance and delivery options to e-mail messages. You 
added and deleted contacts to a contact list. Finally, you used the contact list to create a distribution list and track 
activities of a contact. The items listed below include all the new Outlook skills you have learned in this chapter.

To Quit Outlook

The following steps quit Outlook.

1  Click the Close button on the right side of the title bar to quit Outlook. 

2  If necessary, click the Exit Without Sending button in the Microsoft Offi ce Outlook dialog 
box so that any messages saved in your Outbox are not sent.

 1. Start and Customize Outlook (OUT 5)
 2. Open (Read) an E-Mail Message (OUT 10)
 3. Close an E-Mail Message (OUT 15)
 4. Print an E-Mail Message (OUT 16)
 5. Reply to an E-Mail Message (OUT 16)
 6. Change Message Formats (OUT 19)
 7. Forward an E-Mail Message (OUT 20)
 8. Delete an E-Mail Message (OUT 21)
 9. View a File Attachment (OUT 22)
 10. Create and Insert an E-Mail Signature (OUT 24)
 11. Compose an E-Mail Message (OUT 27)
 12. Format an E-Mail Message (OUT 29)
 13. Attach a File to an E-Mail Message and Send the 

Message (OUT 31)
 14. Categorize E-Mail Messages (OUT 33)
 15. Flag E-Mail Messages (OUT 34)
 16. Sort E-Mail Messages by Category Color (OUT 35)
 17. Create and Apply a View Filter (OUT 36)
 18. Set Message Importance, Sensitivity, and Delivery 

Options on a Single Message (OUT 38)

 19. Change the Default Level of Importance and 
Sensitivity (OUT 40)

 20. Create a Personal Folder (OUT 44)
 21. Create a Contact List (OUT 47)
 22. Change the View and Sort the Contact 

List (OUT 49)
 23. Find a Contact (OUT 50)
 24. Organize Contacts (OUT 51)
 25. Display the Contacts in a Category (OUT 52)
 26. Preview and Print the Contact List (OUT 53)
 27. Use the Contact List to Address an E-Mail 

Message (OUT 55)
 28. Create a Distribution List (OUT 58)
 29. Save a Contact List as a Text File and Display it in 

Notepad (OUT 60)
 30. Track Activities for a Contact (OUT 62)
 31. Search for Outlook Help (OUT 63)
 32. Quit Outlook (OUT 65)

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.

Certifi cation
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you 
to obtain a valuable 
industry credential – 
proof that you have 
the Outlook 2007 skills 
required by employers. 
For more information 
see Appendix F or 
visit the Outlook 2007 
Certifi cation Web page 
(scsite.com/out2007/cert).

B
T
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Quick Reference
For a table that lists how to 
complete the tasks covered in this 
book using the mouse, Ribbon, 
shortcut menu, and keyboard, see 
the Quick Reference Summary at 
the back of this book, or visit the 
Outlook 2007 Quick Reference 
Web page (scsite.com/out2007/qr).
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Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, 
and then enter the Web address scsite.com/out2007/learn. When the Outlook 2007 Learn 
It Online page is displayed, click the link for the exercise you want to complete and then read the 
instructions.
Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test your 
knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of the 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 

Apply Your Knowledge 

Reinforce the skills and apply the concepts you learned in this chapter.

Creating a Contact List
Instructions: Start Outlook. Create a Contacts folder using your name as the name of the new folder. 
Create a contact list using the people listed in Table 1–4. Sort the list by last name in descending 
sequence. When the list is complete, print the list in Card Style view and submit to your instructor.

Table 1–4 Contact Information 

Name Telephone Address E-mail Address Grade Level

Greg Sanders (937) 555-4120 8465 W. 63rd St.
Donner, OH 44772

gsanders@isp.com Junior

Dan Gilbert (937) 555-7539 8868 Ashwood Lane
Donner, OH 44772

dgilbert@isp.com Freshman

Heather Nichols (937) 555-9823 214 W. Lincoln Ave.
Donner, OH 44772

hnichols@isp.com Freshman

Valerie Prince (937) 555-0258 5246 Brookfi eld Ct.
Donner, OH 44772

vprince@isp.com Junior

Rafael Perez (937) 555-6211 9812 River Rd.
Donner, OH 44772

rperez@isp.com Sophomore

Keith Lee (937) 555-3080 7894 Forrest View Lane
Donner, OH 44772

klee@isp.com Sophomore
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Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Categorizing Contacts and Creating a Distribution List
Instructions: Start Outlook. Using the contact list created in Apply Your Knowledge, create a category 
for each grade level (freshman, sophomore, junior, and senior) and categorize each student as follows: 
Greg Sanders – Junior, Dan Gilbert – Freshman, Heather Nichols – Freshman, Valerie Prince – Junior, 
Rafael Perez – Sophomore, Keith Lee – Sophomore.

Create a distribution list consisting of juniors and seniors. When the list is complete, print the 
list in Card Style view and submit to your instructor.

Make It Right

Analyze a document and correct all errors and/or improve the design.

Importing Subfolders for the In the Lab Exercises 
Follow these steps to import subfolders for the following Make it Right and In the Lab exercises:
 1. Connect the USB fl ash drive containing the Data Files for Students to your computer.

 2. Click File on the Outlook menu bar and then click Import and Export.

 3. In the Import and Export Wizard dialog box, click Import from another program or fi le and then 
click the Next button.

 4. In the Import a File dialog box, click Personal Folder File (.pst) and then click the Next button.

 5. In the Import Personal Folders dialog box, click the Browse button to access drive E (your USB 
fl ash drive letter may be different), select the appropriate subfolder, click Open, and then click the 
Next button.

 6. In the Import Personal Folders dialog box, select the appropriate folder from which to import and 
then click the Finish button.

Continued >
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OUT 68   Outlook Chapter 1   Managing E-Mail and Contacts with Outlook

Editing a Contact List
Instructions: Start Outlook. Import the MIR 1-1 Contacts folder (Figure 1–103) into Outlook. See 
the inside back cover of this book for instructions for downloading the Data Files for Students, or see 
your instructor for information on accessing the fi les required in this book.

The contact list contains 20 contacts. The fi ve contacts in Table 1–5 need to have their information 
updated. Locate each contact using the Find a Contact box and change the applicable fi elds.

Print the revised contact list and submit it to your instructor.

Table 1–5 Revised Contact Information 

Name Telephone Address E-mail Address Category

Jennifer Craig (916) 555-5686 354 Rutledge St.
Condor, CA 95702

jcraig@isp.com Blue

Andrew Brinckman (916) 555-4565 8453 Whitcomb St.
Condor, CA 95702

abrinckman@isp.com Blue

Courtney Croel (916) 555-2348 7456 Brummitt Rd.
Condor, CA 95702

ccroel@isp.com Blue

Ryan Bachman (916) 555-7410 4654 Ashford Ct.
Condor, CA 95702

rbachman@isp.com Blue

Kris Davids (916) 555-3647 678 E. 7th Ave.
Condor, CA 95702

kdavids@isp.com Blue

Figure 1–103

Make It Right continued
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In the Lab

Design and/or create Outlook items using the guidelines, concepts, and skills presented in this 
chapter. Labs are listed in order of increasing diffi culty.

Lab 1: Creating a Distribution List and Sending E-Mail
Problem: You are the campaign manager of your mother’s campaign for a city council seat. Besides 
coordinating appearances and advertising, your responsibilities also include soliciting and organizing 
campaign donations.

Instructions Part 1: Perform the following tasks:
 1. Import the Lab 1-1 Contacts folder (Figure 1–104) into Outlook. 

 2. Create two distribution lists: one consisting of monetary donors, the other consisting of 
non-monetary donors. Each contact is categorized by type of donation. 

 3. Print each distribution list and submit to your instructor.

Figure 1–104

Continued >
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Instructions Part 2: Perform the following tasks:
 1. Compose a message to each group created in Part 1. The message to monetary donors should 

thank them for their past support and request donations for this year’s campaign. The message to 
non-monetary donors should thank them for their past support and include a request for the same 
contribution to this year’s campaign.

 2. Set the sensitivity for each message as confi dential.

 3. Using Microsoft Word, create a document called Campaign Platform, and include this fi le as an 
attachment with your e-mail messages.

 4. Set the delivery for each message to March 1, 2008 at 10:00 a.m.

 5. Format your messages to monetary donors as Plain Text and your messages to non-monetary 
donors as HTML.

 6. Print each message and submit to your instructor. 

Instructions Part 3: Save the Lab 1-1 contact list as a text fi le. Open the fi le using Notepad. Print the 
contact list from Notepad and submit to your instructor.

In the Lab

Lab 2: Flagging and Sorting Messages
Problem: As student director of the Computer Help Center, you are responsible for responding to 
questions received by e-mail. Some questions require a more timely response than others, so you need 
a way to sort the questions fi rst by urgency and then by time of receipt.

Instructions: Perform the following tasks: 
 1. Import the Lab 1-2 Inbox folder (Figure 1–105) into Outlook. 

 2. Read through each message and apply the appropriate Follow Up fl ag to each message (Today, 
Tomorrow, or This Week). 

 3. After you have fl agged each message, sort the messages based on the Follow Up fl ag.

Figure 1–105

In the Lab continued
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In the Lab

Lab 3: Creating an E-Mail Signature, Replying To, and Forwarding Messages
Problem: With all the Computer Help Center messages sorted and fl agged, you now have to respond 
to the messages. You need to perform this task in an effi cient manner, as it is the Computer Help 
Center’s policy to respond to questions within three working days. Policy also requires that the name 
of the person responding, the Computer Help Center’s telephone number, and its hours of operation 
appear on every reply.

Instructions Part 1: Perform the following tasks: 
 1. Create an e-mail signature consisting of your name, title (Student Director), a telephone number 

(555-1234), and hours of operation (8:00 a.m. – 8:00 p.m., Closed Sundays). 

 2. Click the New Message button on the Standard toolbar. Print the blank message containing the 
signature and submit to your instructor.

Instructions Part 2: Perform the following tasks: 
 1. Send a reply with the importance set at high to the messages fl agged for follow up Today. 

 2. Forward the messages fl agged for follow up Tomorrow. You may use fi ctitious e-mail addresses for 
this exercise, because the messages will not actually be sent. 

 3. Submit printouts of the replies to your instructor.

Instructions Part 3: Perform the following tasks:
 1. Clear all the This Week Follow Up fl ags from the appropriate messages. Use Search Folders to 

display only the messages fl agged for follow up. Make a list of the sender’s name, subject, and 
Follow Up fl ag type and submit to your instructor.

 2. Using information from Microsoft Outlook Help, create a unique signature for a separate e-mail 
account. See your instructor about setting up a separate e-mail account.

 3. Print a blank message containing the signature and submit to your instructor. 
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Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

• EASIER    •• MORE DIFFICULT

• 1: Create a Personal Contact List
Create a contact list of your family, friends, and colleagues. Include their names, addresses, telephone 
numbers, e-mail addresses, and IM addresses (if any). Enter the employer for each contact if 
appropriate. For family members, use the Detail sheet to list birthdays and wedding anniversaries (if 
any). Print the contact list and submit to your instructor.

• 2: Modify a Contact List
Import the Cases 1-2 Contacts folder into Outlook. You are the manager of the Personnel Department 
for a large automobile dealership. Your responsibilities include updating the company contact list 
whenever someone changes positions, receives a promotion, or other changes occur. Byron Taylor 
has received a promotion to Parts Manager and was rewarded with a private offi ce (Room 3A), private 
telephone ((812) 555-1278), and his own e-mail address (btaylor@autodealer.com). The information 
in his current record contains the general telephone number and dealership’s e-mail. Make the 
appropriate changes to Byron Taylor’s contact record. Submit a printout to your instructor.

•• 3: Apply a View Filter and Track Contact Activities
Import the Cases 1-3 Inbox folder into Outlook. You work in the IT department of a large company. 
Every day you receive several e-mail messages about various computer problems within the company. 
A coworker, Bailey Smithers, has sent several e-mail messages to the IT department complaining that 
her problem has yet to be solved. You have been told to immediately solve her problem. Apply a fi lter 
to the Cases 1-3 Inbox folder to display only the messages from Bailey Smithers. Respond to her latest 
e-mail message while sending a copy to your supervisor to show that you have found a resolution to 
the problem. Submit a printout of your reply to your instructor. Add Bailey Smithers to your contact 
list. Track the activities of Bailey Smithers. List the fi rst fi ve entries from the Activities list and submit 
to your instructor. After printing your reply message, delete all the messages from Bailey Smithers and 
remove the fi lter.

•• 4: Compose and Format an E-Mail Message

Make It Personal
Being involved with your studies, extracurricular activities, and college life in general, can prevent you 
from keeping in touch with family and friends. Compose an e-mail message to a close relative or friend. 
Your message should contain information on your class schedule, activities, and new friends that you 
have made. Compose the message in HTML format. Format the text of your message to enhance its 
appearance. Use Outlook Help to insert a picture of the campus or your school’s logo into the message 
body. Print the e-mail and submit to your instructor.

•• 5: Compile Contact Information

Working Together
Have each member of your team submit a design of a form for collecting contact information. Have 
them base the form on available fi elds in the General and Detail sheets in the Contact window. Have 
the team select the best form design. After selecting a form, make photocopies for the entire class. 
Have your classmates fi ll out the form. Collect the forms and create a contact list from the collected 
information. Print the fi nal contact list and submit to your instructor.
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